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Supplementary figures  

 

Figure S1. Absorbance spectra of m&m-BODIPY and its PNA conjugate (m&m-BODIPY-PNA). Both 
molecules display absorbance maxima at ca. 545 nm in PBS (pH 7.4 20 mM). In addition, m&m-BODIPY-PNA 
displays an added absorbance maxima at 325 nm, which arise for the conjugated PNA. 

 

 

Figure S2. Dark stability of m&m-BODIPY-PNA. The conjugate (500 µM) was incubated in PBS 20 mM pH 7.4, 
supplemented with 10% ACN for the indicated times. At each time point, a sample was taken for HPLC-MS 
analysis. Less than 1% degradation was observed after 6 hours. 
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Figure S3. Light-induced release of model leaving groups from m&m-BODIPY cage. Schematic representation 
(left) and HPLC-MS monitoring (right) of photolysis of A) p-nitrobenzylamine, B) p-nitrophenol and C) p-
nitrophenylacetic acid from the corresponding m&m-BODIPY conjugate, following 540/30 nm irradiation (100 
µM in PBS 20 mM pH 7.4 supplemented with 5% ACN) for indicated times.  

 

Figure S4. Additional controls for Figure 3 in main text: live cell epifluorscence imaging of Ca2+ release triggered 

by m&m-BODIPY-histamine in HeLa cells. All cells were loaded with fura-2 AM and then treated with either 

m&m-BODIPY and green light (A) or green light alone (C). Changes in Fura-2 fluorescence are quantified in panels 

B and D. Spike in D is from refocusing the drifting cells. Changes in B are from bleaching and recovery of the 

highly fluorescent m&m-BODIPY compound. Scale bar is 20 µm. 
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Figure S5. Dark stability of m&m-BODIPY-dopamine and light-induced release of dopamine. Left: Dark stability 

of m&m-BODIPY-dopamine (100 µM in PBS pH 7.4 20 mM, 5% ACN). Less than 9% hydrolysis was observed 

after 6 hours. Right: Accumulation and depletion of dopamine and m&m-BODIPY-dopamine, respectively, 

following 540/30 nm irradiation of BODIPY540-PNBA (65 µM in PBS 20 mM pH 7.4 supplemented with 5% 

ACN) for indicated times, as monitored by HPLC-MS. 

 

 

Figure S6. Additional controls for Figure 4 in main text: live cell epifluorscence imaging of Ca2+ release triggered 

by BODIPY-dopamine in KCl-primed rat cortical/hippocampal neurons. All cells were loaded with fura-2 AM and 

then treated with either green light alone (A) or m&m-BODIPY540 and green light (C). Changes in Fura-2 

fluorescence are quantified in panels B and D. Changes in D are from bleaching and recovery of the highly 

fluorescent m&m-BODIPY compound. Scale bar is 20 µm.  
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General synthetic and analytical methods 

Pyrromethene605 was purchased from Exciton. All other chemicals were purchased from Sigma-Aldrich and used 

as received unless otherwise noted.  Anhydrous solvents and reagents (DCM, THF, DMF) were obtained as 

SureSeal bottles from Sigma-Aldrich. Thin-layer chromatography and flash chromatography were performed using 

EMD pre-coated silica gel 60 F-254 plates and silica gel 60 (230-400 mesh). UV absorbance spectra were recorded 

on a Cary 3E (Varian) fluorimeter.  Fluorescence spectra were recorded on Tecan infinite 200 pro multimode reader 

or  Fluorolog 2 (Spex) fluorimeter. Analytical and preparative HPLCs were performed on Agilent HPLCs, with 

Luna C18(2) columns (Phenomenex) using water (solvent A) and acetonitrile (solvent B) with 0.05% TFA as an 

additive. Low resolution ESI mass spectrometry was performed on an Agilent LC/MSD Trap XCT coupled to an 

Agilent HPLC. High resolution ESI mass spectrometry was performed on a Waters SYNAPT system. 1H- and 13C-

NMR spectra were collected in CDCl3 or CD3OH (Cambridge Isotope Laboratories, Cambridge, MA) at 25 ºC using 

a Bruker Avance III spectrometer at 400 MHz and 100 MHz respectively at the Department of Chemistry NMR 

Facility at Tel-Aviv University. All chemical shifts are reported in the standard δ notation of parts per million using 

the TMS peak as an internal reference. Abbreviations: THF: tetrahydrofurane, DMF: dimethylformamide, DCM: 

dichloromethane, DIPEA: diisopropylethylamine, DMAP: dimethylaminopyridine, PNA: p-nitroaniline, PNP: p-

nitrophenol, PNPA: p-nitrophenylacetic acid, PNBA: p-nitrobenzylamine, EtOAc: ethylacetate, Hex: hexane, RT: 

room temperature, DBTL: dibutyltin dilaurate, DCC: N,N'-Dicyclohexylcarbodiimide, ACN: acetonitrile,  
 

Synthetic procedures 

 

m&m-BODIPY540. Pyrromethene605 (500 mg, 1.3 mmol, 1 eq) was dissolved in 26.5 mL THF to yield a 0.05 M 

solution. LiOH (280 mg, 6.65 mmol, 5 eq) was dissolved in 26.5 mL water, added to the THF solution and the 

reaction was stirred at RT for 3 hours while monitored by TLC. Upon completion, the reaction was diluted with 

EtOAc and washed with saturated NH4Cl solution and brine. The water fractions were extracted with EtOAc. The 

combined organic phase was dried with MgSO4, filtered and solvents were removed under reduced pressure. The 

crude product was purified by silica gel chromatography (5%-20% EtOAc in Hexane gradient) to yield m&m-

BODIPY (280 mg, 0.84 mmol, yield 65%) as a dark orange/brown solid. 
1H-NMR (CDCl3, 400 MHz): δ = 1.05 (t, J = 7.5 Hz, 6H), 1.72 (bs, 1H), 2.40 (q, J = 7.5 Hz, 4H), 2.42 (s, 6H), 2.55 

(s, 6H), 5.30 (s, 2H). 13C-NMR (CDCl3, 100 MHz): δ = 12.7, 14.9, 17.3, 31.1, 56.3, 131.8, 133.5, 136.5, 136.7, 

154.7. ESI-MS (positive mode) calculated (C18H25BF2N2O) 334.2, found m/z [M+H]+ 335.3. ESI-HRMS (positive 

mode) [M+Na]+: m/z calculated: 356.1962, found: 356.1963. λmax (abs.) = 537 nm, ε = 53,300 L∙mol-1 ∙cm-1, Φfl = 

0. 0.90. 
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m&m-BODIPY-PNA. m&m-BODIPY (15 mg, 0.045 mmol, 1 eq) was dissolved in 3 mL toluene and p-

nitrophenylisocyanate (29 mg, 0.180 mmol, 4 eq) and Et3N (catalytic amount) were added. The reaction mixture 

was heated to 50oC and stirred under argon atmosphere for 72 hours. Upon completion, the reaction was diluted 

with EtOAc and washed with saturated NH4Cl solution and brine. The water fractions were extracted with EtOAc. 

The combined organic phase was dried with MgSO4, filtered and solvents were removed under reduced pressure. 

The crude was purified by silica gel chromatography (0%-12% EtOAc in Hexane gradient) to yield m&m-

BODIPY-PNA (16 mg, 0.032 mmol, yield 71%) as a dark orange solid. 

1H-NMR (CDCl3, 400 MHz): δ = 1.04 (t, J = 7.5 Hz, 6H), 2.32 (s, 6H), 2.39 (q, J = 7.5 Hz, 4H), 2.51 (s, 6H), 5.48 

(s, 2H), 7.44 (bs, 1H), 7.58 (d, J = 8.9 Hz, 2H), 8.20 (d, J = 8.9 Hz, 2H). 13C-NMR (CDCl3, 100 MHz): δ = 12.8, 

14.8, 17.3, 31.3, 56.1, 120.1, 125.3, 131.9, 133.4, 136.5, 136.8, 143.2, 144.5, 154.6. ESI-MS (positive mode) 

calculated (C25H29BF2N4O4) 498.3, found m/z [M+H]+ 499.5. ESI-HRMS (positive mode) [M+Na]+: m/z calculated: 

356.1962, found: 356.1963. λmax (abs.) = 545 nm, ε =34,500 L∙mol-1 ∙cm-1, Φfl = 0.71. 

 

 

m&m-BODIPY-PNP. m&m-BODIPY (25.5 mg, 0.076 mmol, 1 eq) was dissolved in 2 mL dry THF. Then, p-

nitrophenylchloroformate (61 mg, 0.3 mmol, 4 eq), DIPEA (66 µL, 0.38 mmol, 5 eq) and pyridine (1.6 µL, 0.02 

mmol, 0.25 eq) were added and the reaction was stirred at room temperature under argon atmosphere for 16 hours. 

Upon completion, the reaction was diluted with EtOAc and washed with saturated NH4Cl solution and brine, dried 

with MgSO4, filtered and solvents were removed under reduced pressure. The crude product was purified by silica 

gel chromatography (EtOAc:Hex 5:95 to 40:60 gradient) to yield m&m-BODIPY-PNP (25 mg, 0.051 mmol, yield 

68%) as a dark orange solid. According to NMR and HPLC-MS, the product contained a small amount of p-

nitrophenol but was nevertheless used for the subsequent reactions without further purification. A small amount 

was purified by prep-HPLC for spectroscopic and photochemical analysis. 
1H-NMR (CDCl3, 400 MHz): δ = 1.06 (t, J = 7.5 Hz, 6H), 2.36 (s, 6H), 2.41 (q, J = 7.5 Hz, 4H), 2.53 (s, 6H), 5.60 

(s, 2H), 7.41 (d, J = 9.1 Hz, 2H), 8.30 (d, J = 9.1 Hz, 2H). 13C-NMR (CDCl3, 100 MHz): δ = 12.9, 14.8, 17.3, 31.1, 

62.3, 121.8, 125.5, 129.3, 132.3, 134.1, 136.7, 145.6, 152.4, 155.4, 155.8. ESI-MS (positive mode) calculated 

(C25H28BF2N3O5) 499.3, found m/z [M+H]+ 500.4. ESI-HRMS (positive mode) [M+Na]+: m/z calculated: 521.2024, 

found: 521.2019. λmax (abs.) = 547 nm, ε = 48,400 L∙mol-1 ∙cm-1, Φfl = 0.54. 

 

 

m&m-BODIPY-PNBA. m&m-BODIPY-PNP (25 mg, 0.051 mmol, 1 eq) was dissolved in 1 mL dry THF. p-

nitrobenzylamine hydrochloride (29 mg, 0.153 mmol, 3 eq) and DIPEA (27 µL, 0.158 mmol, 3.1 eq) were dissolved 
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in 0.5 mL dry DMF and added to the THF solution. The reaction mixture was stirred at room temperature under 

argon atmosphere for 4 hours. Upon completion, the reaction was diluted with EtOAc and washed with saturated 

NH4Cl solution and brine, dried with MgSO4, filtered and solvents were removed under reduced pressure. The crude 

product was purified by preparative HPLC (see Preparative HPLC purification conditions below). The eluted 

product was immediately frozen and lyophilized to yield m&m-BODIPY-PNBA (19 mg, 0.037 mmol, yield 73%) 

as a dark orange solid. 
1H-NMR (CDCl3, 400 MHz): δ = 1.05 (t, J = 7.5 Hz, 6H), 2.30 (s, 6H), 2.40 (q, J = 7.5 Hz, 4H), 2.51 (s, 6H), 4.51 

(d, J = 6.0 Hz, 2H), 5.30 (t, J = 6.0 Hz, 1H),  5.39 (s, 2H), 7.45 (d, J = 8.1 Hz, 2H), 8.21 (d, J = 8.1 Hz, 2H). 13C-

NMR (CDCl3, 100 MHz): δ = 12.8, 14.8, 17.3, 44.7, 59.1, 124.2, 128.1, 131.6, 132.4, 133.8, 136.7, 145.7, 155.3, 

156.1. ESI-MS (positive mode) calculated (C26H31BF2N4O4) 512.3, found m/z [M+H]+ 513.6. ESI-HRMS (positive 

mode) [M+Na]+: m/z calculated: 534.2343, found: 534.2340. λmax (abs.) = 544 nm, ε = 45,000 L∙mol-1 ∙cm-1, Φfl = 

0.69. 

 

 

 

m&m-BODIPY-PNPA. m&m-BODIPY (10 mg, 0.03 mmol, 1 eq) was dissolved in 2 mL dry DCM. Then, PNPA 

(6 mg, 0.033 mmol, 1.1 eq), DCC (7mg, 0.033 mmol, 1.1 eq) and DMAP (4 mg, 0.033 mmol, 1.1 eq) were added 

and the reaction was stirred at RT under argon atmosphere for 16 hours. Upon completion, the reaction was diluted 

with EtOAc and washed with saturated NH4Cl solution and brine, dried with MgSO4, filtered and solvents were 

removed under reduced pressure. The crude product was purified by preparative HPLC (see Preparative HPLC 

purification conditions below). The eluted product was immediately frozen and lyophilized to yield m&m-

BODIPY-PNPA (13 mg, 0.026 mmol, yield 87%) as a dark orange solid. 

1H-NMR (CDCl3, 400 MHz): δ = 1.03 (t, J = 7.5 Hz, 6H), 2.13 (s, 6H), 2.37 (q, J = 7.5 Hz, 4H), 2.51 (s, 6H), 3.80 

(s, 2H), 5.36 (s, 2H), 7.46 (d, J = 8.6 Hz, 2H), 8.19 (d, J = 8.6 Hz, 2H). 13C-NMR (CDCl3, 100 MHz): δ = 12.7, 

12.9, 14.8, 17.3, 41.0, 59.2, 124.0, 130.4, 130.9, 132.3, 133.9, 136.5, 140.7, 154.9, 155.5. ESI-MS (positive mode) 

calculated (C26H30BF2N3O4) 497.3, found m/z [M+H]+ 498.3. ESI-HRMS (positive mode) [M+Na]+: m/z calculated: 

519.2231, found: 519.2233. λmax (abs.) = 545 nm, ε = 38,600 L∙mol-1 ∙cm-1, Φfl = 0.23. 

 

 

m&m-BODIPY-histamine. m&m-BODIPY-PNP (25 mg, 0.051 mmol, 1 eq) was dissolved in 1 mL dry THF. 

Histamine (17 mg, 0.153 mmol, 3 eq) and DIPEA (27 µL, 0.158 mmol, 3.1 eq) were dissolved in 0.5 mL dry DMF 

and added to the THF solution. The reaction mixture was stirred at RT under argon atmosphere for 4 hours. Upon 

completion, the reaction was diluted with EtOAc and washed with saturated NH4Cl solution and brine, dried with 
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MgSO4, filtered and solvents were removed under reduced pressure. The crude product was purified by preparative 

HPLC (see Preparative HPLC purification conditions below). The eluted product was immediately frozen and 

lyophilized to yield m&m-BODIPY-histamine (15 mg, 0.034 mmol, yield 66%) as an orange solid. 

1H-NMR (MeOD, 400 MHz): δ = 1.06 (t, J = 7.5 Hz, 6H), 2.30 (s, 6H), 2.45 (bs Hz, 10H), 3.90 (t, J = 6.6 Hz, 2H), 

3.46 (q, J = 6.6 Hz, 2H), 5.30 (s, 2H), 7.27 (s, 1H), 8.65 (s, 1H). 13C-NMR (CDCl3, 100 MHz): δ = 11.7, 13.9, 16.1, 

24.6, 44.7, 56.9, 118.4, 131.1, 131.9, 132.6, 136.0, 153.5, 155.2. ESI-MS (positive mode) calculated 

(C23H30BF2N5O2) 457.3, found m/z [M+H]+ 458.5. ESI-HRMS (positive mode) [M+Na]+: m/z calculated: 493.2551, 

found: 493.2552. λmax (abs.) = 543 nm, ε = 32,800 L∙mol-1 ∙cm-1, Φfl = 0.72. 

 

 

m&m-BODIPY-dopamine. m&m-BODIPY540-PNP (25 mg, 0.051 mmol, 1 eq) was dissolved in 1 mL dry THF. 

Dopamine hydrochloride (29 mg, 0.153 mmol, 3 eq) and DIPEA (27 µL, 0.158 mmol, 3.1 eq) were dissolved in 0.5 

mL dry DMF and added to the THF solution. The reaction mixture was stirred at RT under argon atmosphere for 4 

hours. Upon completion, the reaction was diluted with EtOAc and washed with saturated NH4Cl solution and brine, 

dried with MgSO4, filtered and solvents were removed under reduced pressure. The crude product was purified by 

preparative HPLC (see Preparative HPLC purification conditions below). The eluted product was immediately 

frozen and lyophilized to yield m&m-BODIPY-dopamine (20 mg, 0.04 mmol, yield 79%) as a dark orange solid. 
1H-NMR (CDCl3+MeOD, 400 MHz): δ = 1.05 (t, J = 7.5 Hz, 6H), 2.27 (s, 6H), 2.39 (q, J = 7.5 Hz, 4H), 2.49 (s, 

6H), 2.69 (t, J = 6.9 Hz, 2H), 3.41 (q, J = 6.5 Hz, 2H), 5.28 (s, 2H), 5.30 (t, J = 6.2 Hz, 1H),  6.54 (dd, J = 8.1, 1.8 

Hz, 1H), 6.67 (d, J = 1.8 Hz, 1H), 6.74 (d, J = 8.1 Hz, 1H). 13C-NMR (CDCl3, 100 MHz): δ = 12.7, 12.8, 14.8, 17.3, 

35.4, 42.5, 58.5, 115.6, 115.9, 121.3, 131.5, 132.2, 132.3, 133.7, 136.9, 142.4, 143.9, 155.0, 156.0. ESI-MS (positive 

mode) calculated (C27H34BF2N3O4) 513.4, found m/z [M+H]+ 514.6. ESI-HRMS (positive mode) [M+Na]+: m/z 

calculated: 535.2544, found: 535.2542. λmax (abs.) = 543 nm, ε = 56,501 L∙mol-1 ∙cm-1, Φfl = 0.69. 

 

Preparative HPLC purification conditions.  

All preparative separations were performed on Agilent HPLC system (1200 series) with Luna 10 µm PREP C18(2) 

column (250.0 X 21.2 mm, 100 Å), using a water-acetonitrile gradient of 25% to 100% solvent B in 20 minutes 

then 5 minutes at 100% solvent B at flow rate of 15 mL/min (solvent A = water, solvent B = acetonitrile, both with 
0.05% TFA as an additive). 

Fluorescence quantum yield and molar absorption coefficient measurements.  

The quantum fluorescence yields (Φfl) of all compounds were determined in ethanol using the comparative method 

with Pyrromethene605 in ethanol as standard (Φfl = 0.74). Recordings were performed at room temperature.  

Molar absorption coefficients (ε) and maximum absorbance wavelengths (λmax) were determined in PBS (pH 7.4, 

50 mM) supplemented with 5% ACN using Beer’s law, from plots of absorbance vs. concentration (for example, 

see Figure S7A). Recordings were performed in 10 mm path length quartz cuvettes at room temperature. 

 



S10 

 

General photolysis and monitoring procedures.  

Compound sample (2 mL of 100 µM in PBS 20 mM pH 7.4 supplemented with 5% ACN) was placed in 10x10x30 

mm quartz cuvette (10 mm path) equipped with an internal magnetic stirrer. The cuvette was placed in a Solar 

Simulator fitted with a 540/30 nm filter and irradiated for the indicated times while constantly stirred. Light intensity 

at the cuvette was measured by light meter to be 49.1 ± 0.2 mW/cm2 in all experiments. At each time point, samples 

were taken for analysis by spectrophotometer and/or HPLC-MS. For spectrometry, samples were diluted 20-fold in 

ACN to ensure absorbance reading within the linear range. For HPLC-MS, samples were diluted 5-10-fold in ACN 

and span down to remove salts. 

Calibration curves for all tested and reference compounds were generated in each detection method 

(spectrophotometer or HPLC-MS). As an example, the calibration curves generated for m&m-BODIPY-PNA 

photolysis monitoring are presented below, including raw data for HPLC analysis (data from spectrophotometer is 

presented in Figure 2B): 
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Figure S7. Calibration curves for m&m-BODIPY-PNA photolysis analysis. A) Left: absorbance spectra of 

BODIPY540-PNA at indicated concentrations (in PBS 20 mM pH 7.4). Right: Calibration curve generated from 

left at 545 nm. B) Left: absorbance spectra of PNA at indicated concentrations (in PBS 20 mM pH 7.4, 5% ACN). 

Right: Calibration curve generated from left at 377 nm. C) Left: HPLC chromatograms of m&m-BODIPY-PNA at 

indicated concentrations (µM), as monitored at 540 nm. Right: Calibration curve generated from left. D) Left: HPLC 

chromatograms of PNA at indicated concentrations (µM), as monitored at 380 nm. Right: Calibration curve 

generated from left. E, F) HPLC chromatograms of m&m-BODIPY-PNA (100 µM in PBS 20 mM pH 7.4) after 

light irradiation (540/30 nm 49 mW/cm2) for indicated times, as monitored at E) 540 nm or F) 380 nm. 

 

General Cell Culture Methods 

HeLa cells were cultured in DMEM with 10% FBS and plated on 12 mm round poly-D-lysine coated coverslips in 

24 well trays at a density of 1.6x105 cells/well 12-18 hours prior to imaging experiments. Prior to imaging, cells 

were incubated with 2 μM fura2-AM (LifeTech) in HBSS at room temperature (25 °C) for 1 hour, washed once, 

and transferred to a 35 mm imaging dish containing 2 mL HBSS. Compounds (m&m-BODIPY photocages) were 

diluted from stocks in DMSO (1000x) to 3x concentration in 1 mL HBSS. This was added to the imaging dish and 

then the experiment began. Pyrilamine maleate (1 μM, Sigma) was added prior to addition of the BODIPY 

compounds.  

Neurons were harvested from rat embryonic hippocampus and cortex. After culturing for 14 days in vitro (DIV) in 

neurobasal media supplemented with B27, cells were loaded in a fashion identical to the HeLa cells described 

above. (+)-butaclamol (100 μM, Sigma) was added prior to treatment with dopamine (10 μM) or BODIPY 

compounds (10 μM). Neurons were treated with a 3x stock of KCl (150 mM stock, 50 mM final) to prime the 

response to dopamine. After initial Ca2+ transients, as measured by fura-2 reached baseline levels, dopamine or 

BODIPY was added and the photolysis began. All animal care and experimental protocols were approved by the 

Animal Care and Use Committee at UC Berkeley 

Imaging Instrumentation and Experimental  

All imaging was performed on an AxioExaminer Z-1 (Zeiss) equipped with a Spectra-X Light engine LED light 

(Lumencor). Light was delivered through a W-Plan-Apo 20x/1.0 objective and focused onto a OracFlash4.0 sCMOS 

camera (Hamamatsu). Excitation for fura-2 imaging was provided at 390/22, passed through a quadruple dichroic 

mirror (432/38, 509/22, 586/40, 654LP), and a quadruple emission filter (430/32, 508/14, 586/30, 708/98). In this 

configuration, increases in [Ca2+]i result in decreases in fura-2 fluorescence. Bleaching of BODIPY compounds was 

conducted at 542/33 nm, passing through the same dichroic and emission filter. Samples were uncaged with 542 

nm light for 15 seconds at maximum power, followed by fura-2 imaging, 25 ms exposures every second for ~5 

minutes after uncaging.  

Data Analysis  

Plots of ΔF/F were constructed by creating regions of interest (ROI) around cells, subtracting background (ROI of 

non-cell region), and dividing by the mean fluorescence for the first 10 frames of the acquisition. These values were 

plotted as ΔF/F vs. time. 

HeLa cells: Images opened in FIJI (v1.49b, FIJI is just ImageJ, NIH). Corrected drift, with 

Plugins>Registration>StackReg>Rigid Body Transformation. Bleaching was corrected, if necessary, with 

Image>Adjust>Bleach Correction>Exponential Fit. Then an average intensity Z-project was calculated for the first 

10 frames (to set F0). The Registered, Bleach-corrected stack was then divided by F0 to give the F/F0 movie, which 

was scaled from 0.75 to 1.25 in all cases, except for SI Movie 5, which was m&m-BODIPY540 control.  
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Neurons: Images opened in FIJI (v1.49b, FIJI is just ImageJ, NIH). Corrected drift, with 

Plugins>Registration>StackReg>Rigid Body Transformation. Bleaching was corrected, if necessary, with 

Image>Adjust>Bleach Correction>Exponential Fit. Then an average intensity Z-project was calculated for the 10 

frames near the beginning of the acquisition (to set F0). The Registered, Bleach-corrected stack was then divided 

by F0 to give the F/F0 movie, which was scaled from 0.75 to 1.25 in all cases except for SI Movie 11, which was 

m&m-BODIPY540 control.  

 

 

  



S13 

 
 



S14 

 
 



S15 

 
 



S16 

 
 



S17 

 
 



S18 

 
 



SI movies legends: 

Movie 01 – HeLa cells treated with histamine 

Movie 02 – HeLa cells treated with m&m-BODIPY-histamine and 540 nm light 

Movie 03 – HeLa cells treated with m&m-BODIPY-histamine, 540 nm light and pyrilamine 

Movie 04 – HeLa cells treated with m&m-BODIPY-histamine, no light 

Movie 05 – HeLa cells treated with 540 nm light only 

Movie 06 – HeLa cells treated with m&m-BODIPY-OH and 540 nm light 

Movie 07 – Neuron cells treated with dopamine 

Movie 08 – Neuron cells treated with m&m-BODIPY- dopamine and 540 nm light 

Movie 09 – Neuron cells treated with m&m-BODIPY- dopamine, 540 nm light and (+)-butaclamol 

Movie 10 – Neuron cells treated with m&m-BODIPY- dopamine, no light 

Movie 11 – Neuron cells treated with 540 nm light only 

Movie 12 – Neuron cells treated with m&m-BODIPY-OH and 540 nm light 

 

 




